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Page 1 MULTIFUNCTIONAL DIGITAL SYSTEMS Printing Guide...

Page 2 ©2009 TOSHIBA TEC CORPORATION All rights reserved Under the copyright laws, this
manual cannot be reproduced in any form without prior written permission of TTEC. No patent
liability is assumed, however, with respect to the use of the information contained herein.

Page 3: Preface
Preface Thank you for purchasing TOSHIBA Multifunctional Digital Systems. This guide describes
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instructions on how to set up the printer drivers required for this equipment, and how to print
with them. Read this manual before using your Multifunctional Digital Systems. Keep this
manual within easy reach, and use it to configure an environment that makes best use of the e-
STUDIO’s functions.

Page 5: Table Of Contents
CONTENTS Preface... 1 Chapter 1 OVERVIEW Features and Functions ... 6 About Printer Drivers
... 7 For Macintosh... 7 For UNIX/Linux ... 7 Chapter 2 PRINTING FROM WINDOWS Before Using
the Printer Driver... 10 Configuring the options... 10 Setting the department code ... 12 Copying
the PPD file for Windows...

Page 6 Proof Print jobs ... 132 Private Print jobs ... 135 Hold Print jobs ... 139 Invalid jobs ...
143 Printing files from USB media (USB Direct Printing) ... 146 Viewing the Print Job Log ... 151
Chapter 6 OTHER PRINTING METHODS FTP Printing ...

Page 7 OVERVIEW This chapter gives an overview of the printing functions. Features and
Functions... 6 About Printer Drivers ... 7 For Macintosh...7 For UNIX/Linux ...7...

Page 8: Overview
1 OVERVIEW Features and Functions Extensive Client Platform Support This equipment supports
printing from IBM-compatible PC, Macintosh, and UNIX/Linux workstations. Not all features are
supported on all platforms, however. Various Port Options You can map this equipment to print
to an SMB, IPP, Raw TCP, or LPR port. Multiple Job Types Job Types refer to the way this
equipment handles a print job.

Page 9: About Printer Drivers
About Printer Drivers Printer drivers required for each OS are included in the Client Utilities CD-
ROM. For instructions on how to install them, refer to the Software Installation Guide. For
Macintosh The printer driver required for Macintosh OSs is included in the following folder of the
Client Utilities CD-ROM: Macintosh PPD files [Client Utilities CD-ROM]:MacPPD:OSX This includes
the PPD file to enable printing from Macintosh on the Mac OS X 10.2.4 to Mac OS X 10.5.x.

Page 11 PRINTING FROM WINDOWS This chapter describes the instructions on how to print
from a Windows computer. Before Using the Printer Driver... 10 Configuring the options ...10
Setting the department code ...12 Copying the PPD file for Windows ...14 Printing from an
Application ... 15 Considerations and limitations...15 How to print ...16 Setting Up Print
Options...

Page 12: Before Using The Printer Driver
2 PRINTING FROM WINDOWS Before Using the Printer Driver Before printing, you have to
configure the following option: Configuration Settings To use optional devices such as optional
drawers, Finisher or Hole Punch Unit, you must first configure these devices. The features of
these optional devices are not available unless you tell the system that the optional devices are
installed.

Page 13 2.PRINTING FROM WINDOWS Select the printer driver for this equipment, and click
the [File] menu, [Run as administrator] and select [Properties]. Enter the administrator
password if required. If the [File] menu is not displayed, press [Alt]. The [User Account Control]
dialog box appears. The printer driver properties dialog box appears if the User Account Control
setting is disabled.

Page 14: Setting The Department Code
2 PRINTING FROM WINDOWS Set the following options and click [OK]. Drawer 1 — Select the
size and type of paper that is loaded in the 1st Drawer. Drawer 2 — Select the size and type of
paper that is loaded in the 2nd Drawer. Drawer 3 —...

Page 15 2.PRINTING FROM WINDOWS Entering department code Click the [Start] menu,
[Control Panel], [Hardware and Sound] and select [Printer]. The Printers folder appears. For
Windows XP or Windows Server 2003 Click the [Start] menu and select [Printers and Faxes]. For
Windows 2000 Click the [Start] menu, [Settings] and select [Printers].
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Page 16: Copying The Ppd File For Windows
2 PRINTING FROM WINDOWS Copying the PPD file for Windows The Client Utilities CD-ROM
contains a printer description file for popular Windows applications. For applications not
allowing the automatic installation of PPD files, copy the PPD file to a proper directory in order
to enable printer-specific settings in the [Print] dialog box or the [Page Setup] dialog box.

Page 17: Printing From An Application
Printing from an Application This section describes how to print a document from an application.
P.15 “Considerations and limitations” P.16 “How to print” Considerations and limitations When
the User Management Setting is enabled on the equipment, the user name that is entered to log
in to your computer is used for the authentication of the print job.

Page 18: How To Print
2 PRINTING FROM WINDOWS How to print Once you have installed the printer driver and
configured it properly, you can print directly from most Windows applications. Simply choose
the Print command from your application. You can print using the various functions by setting
print options on the printer driver. Printing from Windows applications The following describes
an example for printing from Notepad on Windows Vista.

Page 19 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS Click [Print] to print a
document. Printing from an Application...

Page 20: Setting Up Print Options
2 PRINTING FROM WINDOWS Setting Up Print Options Print Options are the attributes you set to
define the way a print job is processed. For example, the private print and proof print options
determine how the copier manages your print job. To find the printing instructions for your
specific needs, see the procedures in the following section.

Page 21: Saving Profiles
2.PRINTING FROM WINDOWS In order to print a document using profiles, you must first create
the saved profile. P.19 “Saving profiles” Once you save a profile, you can apply its settings to a
print job. P.20 “Loading profile” You can also delete unnecessary profiles. P.20 “Deleting
profile”...

Page 22 2 PRINTING FROM WINDOWS Loading profile Select a profile in the [Profile] box. The
setting options in the profile are reflected on each tab. To restore the default settings after you
select the profile, click [Restore Defaults] on each tab. Selecting [None] on the [Profile] box will
not restore them.

Page 23: Print Options
2.PRINTING FROM WINDOWS Print options This section describes print options in each tab of the
printer driver. This section will help you to find the description of specific print options, or
understand the functions of each print option. How to display: Click the [Start] menu, [Control
Panel], [Hardware and Sound] and select [Printer].

Page 24 2 PRINTING FROM WINDOWS - [Effect] tab The [Effect] tab contains print options that
add the effects to your print jobs such as Watermarks, Overlay Image printing and so on. P.41
“[Effect] tab” - [Others] tab The [Others] tab contains special features such as toner save,
custom pager size, and so on. P.44 “[Others] tab”...

Page 25 2.PRINTING FROM WINDOWS If the print job has several pages in the document, only
the first page of the document will be saved as an overlay file. Both the overlay file and the
documents on which you superimpose the overlay image must be created at the same size and
orientation.

Page 26 2 PRINTING FROM WINDOWS [Basic] tab The [Basic] tab contains basic print
operation settings, such as the original paper size, print paper size, paper source, paper type,
number of copies, orientation, and so on. 1) Original Paper Size This option selects the size of a
document to be printed. Available original paper sizes are listed below: Letter (8 1/2 x 11")
Legal (8 1/2 x 14")

Page 27 2.PRINTING FROM WINDOWS 4) Paper Source This option selects the paper source.
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Please select a paper source that correlates with the printing size. - Auto — Automatically
selects the paper set in this equipment according to the printed document size. - Drawer 1 —...

Page 28 2 PRINTING FROM WINDOWS Primary Tab Dialog 1) Tab Manufacturer Select the
product name of the tab paper that you use. This equipment supports following tab paper. For
Letter Tab: Blanks USA copy Tabs (5 Banks) LT + 1/2" Tab Blanks USA copy Tabs (8 Banks) LT +
1/2"...

Page 29 2.PRINTING FROM WINDOWS The tab paper cannot be fed from the Large Capacity
Feeder (optional) and drawers. When you place the tab paper on the Bypass Tray, make sure
the tab side of the paper is facing outward. The job will be output to the exit tray.

Page 30 2 PRINTING FROM WINDOWS - Group Copies — Select this option for group-printing
(1, 1, 1... 2, 2, 2... 3, 3, 3...). - Rotated Sort Copies — Select this option for rotate sort-printing.
[Group Copies] and [Rotated Sort Copies] can be selected only when more than 1 copy is
entered in the [Number of Copies] box.

Page 31 2.PRINTING FROM WINDOWS 2-Sided printing cannot be set when the following
paper size is selected at the [Print Paper Size] box in the [Basic] tab. - A6 - A4 Tab - Letter Tab -
Env-Com10 (4 1/8 x 9 1/2”) - Env-Monarch (3 7/8 x 7 1/2”) - Envelope DL (110 x 220 mm) -
Envelope Cho-3 (120 x 235 mm)

Page 32 2 PRINTING FROM WINDOWS - Upper Left — Select this option to staple the printed
document in the upper left. - Upper Right — Select this option to staple the printed document in
the upper right. - Center Top — Select this option to double staple the printed document along
the top edge. - Middle Left —...

Page 33 2.PRINTING FROM WINDOWS The selectable options vary depending on the paper
size. The “Staple” option is available only when the Finisher (optional) is installed. [Center
Double] can be selected only when the Saddle Stitch Finisher (optional) is installed. The
“Staple” option is not available when 2-Sided printing is selected together with the Magazine
sort function. Stapling cannot be set when the following paper sizes are selected in the [Print
Paper Size] box in the [Basic] tab.

Page 34: Booklet Details
2 PRINTING FROM WINDOWS 6) Use Custom Margin Select this check box to set the margin on
the printed pages. When this box is selected, click [Details] to set the margins in the [Custom
Margin] dialog box. The margin range is between 4.2 mm and 100 mm (0.17 inches and 3.94
inches). Less than 4.2 mm cannot be set for the range.

Page 35 2.PRINTING FROM WINDOWS 3) Margin - Center This option sets the gutter in the
center of a two sided page. You can enter up to 0.50 inches (12.70 mm). The printed images will
be reduced according to the margin setting. 4) Margin - Outer This option sets the gutter on the
right side and left side on the paper.

Page 36 2 PRINTING FROM WINDOWS [Paper Handling] tab The [Paper Handling] tab allows
you to enable Front Cover printing, Back Cover printing, Inserting Pages, and Interleaving
Pages. “Use Front Cover”, “Use Back Cover”, “Insert Pages” and “Interleave Pages” are not
available when the Tab printing function is set.

Page 37 2.PRINTING FROM WINDOWS The selectable values in the [Source] box vary
depending on the optional devices installed on this equipment and their configuration in the
[Configuration] tab. Print Style This option selects how you want to print a front cover. - Do not
print on page —...

Page 38 2 PRINTING FROM WINDOWS 4) Insert Pages This option sets sheet insertion printing
which allows you to insert a sheet between pages, or print a specific page on a sheet fed from a
tray other than the Paper Source option selected in the [Basic] tab. This option is useful when
you want to insert a blank sheet between chapters, or when you want to print chapter cover
pages on different paper.

Page 39 2.PRINTING FROM WINDOWS Insert Pages 1) Page Enter the page number where the
sheet is to be inserted. When [Blank] is selected from the [Print Style] box, the blank sheet is
inserted before the entered pages. When [1 Side] is selected from the [Print Style] box, the
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entered page will be printed on the inserted sheet. A sheet cannot be inserted before the first
page when 2-Sided printing is enabled.

Page 40 2 PRINTING FROM WINDOWS 9) Image Shift Width Enter the width to shift the
printed image. For example, if you want to print text on the tab extension of Letter Tab paper,
create a Letter sized document and input the text on the right side. Specify the distance the
printed image is shifted in printing on tab paper. When creating a document for tab printing,
you must place the text at the exact height to fit the tab extension.

Page 41 2 PRINTING FROM WINDOWS 2.PRINTING FROM WINDOWS If [Blank] is selected while
2-sided printing is performed, and you enter an even numbered page (printed on the back side
of the paper) for the [Pages] box, the specified page will be blank. The desired blank sheet is
inserted next and the 2-sided printing continues from the next page.

Page 42 2 PRINTING FROM WINDOWS [Image Quality] tab The [Image Quality] tab allows you
to select how images are printed. You can easily select appropriate image quality depending on
the type of document. 1) Halftone This option sets how halftones are printing. PCL6 Printer
Driver - Detail —...

Page 43 2.PRINTING FROM WINDOWS [Effect] tab The [Effect] tab contains print options that
add effects to your print jobs such as Watermarks, Overlay Image printing, Rotate printing,
Mirror printing, and Negative printing. [Effect] tab for PCL6 [Effect] tab for PS3/XPS 1)
Watermark This option selects the watermark to be used or edited.

Page 44 2 PRINTING FROM WINDOWS [Add] Click this button to create a new watermark. The
[Watermark] dialog box will appear upon clicking this button. P.43 “Add/Edit Watermark” [Edit]
Select a watermark from the [Watermark] box and click [Edit] to edit the watermark. The
[Watermark] dialog box will appear upon clicking this button.

Page 45 2.PRINTING FROM WINDOWS 5) Negative/Positive Select this check box to perform
negative printing of an image. This print option is not displayed for the PCL6 printer driver.
Negative printing may not be applied when the application gives priority to the application’s
PostScript settings over the printer driver settings.

Page 46 2 PRINTING FROM WINDOWS 11) Draw as Outline Select this option to print an
outline type of watermark. 12) Transparency Select this option to print a transparent
watermark. When you select this option, set the transparency from 0 (darker) to 100% (lighter)
in units of 1%.

Page 47 2.PRINTING FROM WINDOWS 2) Toner Save Select this check box to print in toner
save mode. When the toner save mode is enabled, printing may become lighter. 3) Do not Print
Blank Pages Select this check box to ignore blank pages for printing. If Watermark feature is
enabled all pages will be printed even when the content is blank.

Page 48 2 PRINTING FROM WINDOWS When the User Management Setting is enabled on the
equipment, the User Management Setting is used to manage the print jobs instead of the
department code. In that case, the user name that is entered to log in to your computer is used
for the authentication of the print job.

Page 49: Custom Paper Size
2.PRINTING FROM WINDOWS 13) [Restore All Defaults] Click this button to return settings in all
the tab menus other than the [Font] and [Configuration] tab menus to the default ones. When
you click this button, a confirmation dialog box will appear. Click [OK] on the dialog box to
return print settings in all the tab menus to the default ones.

Page 50: Postscript Settings
2 PRINTING FROM WINDOWS PostScript Settings 1) Output Format This option selects the output
format for printing. - ASCII — Select this option to send in ASCII data format. - Encapsulated
PostScript (EPS) — Select this option to send in EPS format. - Tagged BCP —...

Page 51 2.PRINTING FROM WINDOWS [Fonts] tab The [Fonts] tab allows you to select how the
TrueType fonts are printed. The [Fonts] tab can be displayed only from the Printers folder (and
not displayed when displaying the properties from the application’s print dialog box). To adjust
settings in the [Font] tab menu, you need to select the printer driver of this equipment in the
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Printers folder, and then click the [File] menu, [Run as administrator] and select [Properties].

Page 52 2 PRINTING FROM WINDOWS 1) TrueType Options This option sets how to print
TrueType fonts. - Always Use TrueType Fonts — Select this option to print the document the
same as the print image shown on the screen. All TrueType fonts are extracted on the system
for printing. - Always Use Printer Fonts —...

Page 53 2.PRINTING FROM WINDOWS [Configuration] tab The [Configuration] tab allows you
to configure options. When any optional unit is installed in this equipment, set the configuration
of the machine on this tab. The [Configuration] tab can be displayed only from the Printers
folder (and not displayed when displaying the properties from an application’s print dialog box).

Page 54 2 PRINTING FROM WINDOWS - Saddle Stitch Finisher — Select this option when the
Saddle Stitch Finisher MJ-1025 (optional) is installed. - Job Separator — Select this option when
the Job Separator MJ-5004 (optional) is installed. - Offset Tray — Select this option when the
Offset Tray (optional) is installed. Hole Punch Unit This option sets whether or not the Hole
Punch Unit (optional) is installed.

Page 55: Drawer Settings
2.PRINTING FROM WINDOWS Drawer Settings 1) Paper Size Select the paper size set in each
drawer. 2) Paper Type Select the paper type set in each drawer. 3) Attribute Select the attribute
of the paper. When you set the attribute, the drawer will be selected preferentially according to
the print settings.

Page 56: Account Settings
2 PRINTING FROM WINDOWS Account Settings When SNMP communication is enabled, the
following account information is automatically obtained from the equipment. 1) Use User
Authentication Select this check box to enable the user management function. 2) User Name
The user name that is entered to log in to your computer is displayed. 3) Domain Name The
domain name on which the equipment belongs is displayed.

Page 57: Printing With The Best Functions For Your Needs
Printing with the Best Functions for Your Needs In this section, procedures are given to print
various types of print jobs, using the layout and finishing options. Read this section before
starting printing and select a procedure best suited for your needs. P.55 “Printing various print
job types”...

Page 58: Printing Private Print Jobs
2 PRINTING FROM WINDOWS Select the [Time] box and click the spin button to change the time.
To change the hour, select the hour number and click the spin button. To change the minute,
select the minute number and click the spin button. Click [OK].

Page 59 2.PRINTING FROM WINDOWS Select the desired user name and press [PASSWORD].
When you enter the nickname for the [User name (Alias)] box on the [Others] tab, and send the
job to the equipment, its nickname will be displayed on the Private Print job list. If not, the user
name that is entered to log in to your computer will be displayed on the Private Print job list.

Page 60: Printing Proof Print Jobs
2 PRINTING FROM WINDOWS Printing Proof Print jobs You can print out one proof copy as a trial
first. This feature helps to prevent wasting paper. After viewing the first copy, you can decide
whether to print out the remaining copies or cancel the job. When you want to print multiple
copies, each of which is to be sent as an individual print job by your application, all the copies,
not just one copy, will be printed even if you set Proof Print.

Page 61: Creating An Overlay File
2.PRINTING FROM WINDOWS Creating an overlay file You can save up to 20 documents as
overlay files using the printer driver. You can print an overlay on the foreground or background
of a document. To do that, you must first create an overlay file. P.74 “Printing with an overlay
file”...

Page 62 2 PRINTING FROM WINDOWS Storing to e-Filing The Store to e-Filing feature allows
you to send print jobs to e-Filing on this equipment. The job stored to e-Filing can then be
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printed from the touch panel display at a later time. It can also be composed with other
documents using the e-Filing web utility.

Page 63 2.PRINTING FROM WINDOWS If you print the job as well as saving to the public box,
select the [Print] check box. Click [OK]. Click [OK] or [Print] to send the print job. The print job is
saved to the public box. Saving a print job to a user box Display the [Basic] tab menu.

Page 64: Layout And Finishing Options In The [Basic] Tab Menu
2 PRINTING FROM WINDOWS Layout and finishing options in the [Basic] tab menu Using the
printer driver, you can set various layout options to suit your preferences. In this section,
various printing functions enabled with the [Basic] tab menu are explained. P.62 “Fitting images
within paper size”...

Page 65: Layout And Finishing Options In [Finishing] Tab Menu
2.PRINTING FROM WINDOWS Layout and finishing options in [Finishing] tab menu Using the
printer driver, you can set various layout options to suit your preferences. In this section,
various printing functions enabled with the [Finishing] tab menu are explained. P.63 “Sort
printing” P.64 “Printing on both sides of a sheet”...

Page 66: Printing On Both Sides Of A Sheet
2 PRINTING FROM WINDOWS Sorting printed documents horizontally and vertically for each
copy The rotate sort mode can be enabled only when printing on Letter, A4, B5, or 16K. Display
the [Basic] tab menu. Enter the number of copies to be printed at the [Number of Copies] box.
Display the [Finishing] tab menu.

Page 67 2.PRINTING FROM WINDOWS Making a booklet Printing in normal booklet mode
produces a document that, when folded, becomes a properly paginated booklet or magazine-
style publication. You can even create bound booklets that are folded and stapled in the center.
For example, if you create a document on letter-size paper (8½ x 11 inches) and then print in
booklet mode, the yield is a 5½-x-8½- inch booklet.

Page 68 2 PRINTING FROM WINDOWS Letter-Half on Letter — Select this option to print a 1/2
Letter size booklet. Every 2 pages are printed on Letter paper to fit on half a sheet. LT on LD —
Select this option to print a Letter size booklet. Every 2 pages are printed on Ledger paper to fit
on half a sheet (Letter).

Page 69: Printing Several Pages On One Sheet
2.PRINTING FROM WINDOWS Printing several pages on one sheet The N-up feature allows you to
print several pages of a document on one sheet of paper. This feature is very useful for
browsing a large number of pages for appearance or page order. For example, to check the
navigation path of a number of web pages or review the narrative of a slide presentation, using
N-up is not only convenient but conserves paper as well.

Page 70 2 PRINTING FROM WINDOWS Stapling You can staple sets of paper. Stapling is not
available if a Finisher (optional) is not installed. Stapling the paper Display the [Finishing] tab
menu. Select the [Staple] check box. Select a stapling option. Upper Left —...

Page 71: Hole Punching
2.PRINTING FROM WINDOWS Hole punching Select this function to punch holes in printed sheets
of paper. Hole punching is not available if a Hole Punch Unit (optional) is not installed. Punching
holes Display the [Finishing] tab menu. Select the [Hole Punch] check box. Select a hole punch
option. Center Top —...

Page 72: Finishing Options In The [Paper Handling] Tab Menu
2 PRINTING FROM WINDOWS Finishing options in the [Paper Handling] tab menu Using the
printer driver, you can set various layout options to suit your preferences. In this section,
various printing functions enabled with the [Paper Handling] tab menu are explained. P.70
“Inserting different types of paper”...

Page 73 2.PRINTING FROM WINDOWS Enter the page numbers at which you want to insert
the sheet in each [Page] box and select the [Print Style], [Paper Source], and [Paper Type]
options as required. Set any other print options as required and click [OK]. Click [OK] or [Print]
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to send the print job.

Page 74: Finishing Options In The [Effect] Tab Menu
2 PRINTING FROM WINDOWS Finishing options in the [Effect] tab menu Using the printer driver,
you can set various layout options to suit your preferences. In this section, various printing
functions enabled with the [Effect] tab menu are explained. P.72 “Printing with watermarks”
P.74 “Printing with an overlay file”...

Page 75 2.PRINTING FROM WINDOWS Creating or editing a watermark Click [Add] to create a
new watermark, or select a watermark that you want to edit and click [Edit] to edit the
watermark. The [Watermark] dialog box appears. Adjust the position of the watermark by
specifying X and Y values in [Position]. If you click [Center Watermark], the watermark is placed
at the center of the page.

Page 76: Printing With An Overlay File
2 PRINTING FROM WINDOWS Deleting a watermark You can delete the default watermarks.
However, they cannot be restored by clicking [Restore Defaults]. Select the watermark that you
want to delete at the [Watermark] box. Click [Delete]. The [Confirm Delete] dialog box appears.
Click [Yes].

Page 77 2.PRINTING FROM WINDOWS Set any other print options as required and click [OK].
Click [OK] or [Print] to send the print job. The print job is printed with the overlay image.
Deleting an overlay image Select an overlay image that you want to delete at the [Overlay
Image] box. Click [Delete].

Page 78: Using Various Types Of Paper
2 PRINTING FROM WINDOWS Using various types of paper This equipment allows you to print on
various types of paper. The procedure below is for print jobs which require precautions before
placing paper. P.76 “Printing on tab paper” P.78 “Printing on paper larger than standard sizes”
Printing on tab paper This equipment supports tab printing, which can print in the tab extension
of the tab paper.

Page 79 2.PRINTING FROM WINDOWS When printing a document, display the [Basic] tab
menu of the printer driver properties, select document size in the [Original Paper Size] box, and
select either [Letter Tab] or [A4 Tab] (according to the document size) in the [Print Paper Size]
box. The [Primary Tab Dialog] dialog box appears.

Page 80: Control Panel
2 PRINTING FROM WINDOWS Printing on paper larger than standard sizes The procedure below
is for printing on paper larger than standard sizes defined in the custom paper size setting.
(Largest size: 11.70 x 17 inches (297 x 432 mm)) Custom paper sizes can be defined in the
[Other] tab menu.

Page 81 PRINTING FROM MACINTOSH This chapter provides the instructions on how to print
from a Macintosh computer. Printing from an Application on Mac OS X 10.2.4 to Mac OS X 10.5.x
... 80 Considerations and limitations...80 How to print from Mac OS X 10.2.4 to Mac OS X 10.5.x
...81 Page Setup dialog on Mac OS X 10.2.4 to Mac OS X 10.5.x ...83 Print dialog on Mac OS X
10.3.x to Mac OS X 10.5.x ...88 Print dialog on Mac OS X 10.2.x ...102...

Page 82: Printing From An Application On Mac Os X 10.2.4 To Mac Os X
10.5.X
3 PRINTING FROM MACINTOSH Printing from an Application on Mac OS X 10.2.4 to Mac OS X
10.5.x Once you have installed the PPD file as described in “Installing the Printer on Mac OS X
10.2.4 to Mac OS X 10.5.x” of the Software Installation Guide, you can print directly from most
of the Mac OS X applications.

Page 83: How To Print From Mac Os X 10.2.4 To Mac Os X 10.5.X
3.PRINTING FROM MACINTOSH How to print from Mac OS X 10.2.4 to Mac OS X 10.5.x You do
not need to switch printers before starting printing because they are all managed under the
setting of [Print & Fax] of [System Preferences]. Once a printer is added to the Printer List, you
can select any printer directly from the [Page Setup] dialog box or the [Print] dialog box.
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Page 84 3 PRINTING FROM MACINTOSH Click [Print] to print a document. The content set in
the [Print] dialog box can be saved as [Presets]. Select [Save as] in the [Presets] box and save it
under the desired name. If you use this preset content as the default setting, select it in the
[Presets] box.

Page 85: Page Setup Dialog On Mac Os X 10.2.4 To Mac Os X 10.5.X
3.PRINTING FROM MACINTOSH Page Setup dialog on Mac OS X 10.2.4 to Mac OS X 10.5.x The
[Page Setup] dialog boxes can be displayed by selecting the [Page Setup] command from the
[File] menu of the application. In the [Page Setup] dialog boxes, you can specify the Page
Attributes settings and manage the Custom Page Size settings.

Page 86: Custom Page Sizes
3 PRINTING FROM MACINTOSH Custom Page Sizes The PPD file for this equipment supports the
Custom Page Sizes. The procedure to create the Custom Page Size varies between the Mac OS
X 10.4.x to Mac OS X 10.5.x and Mac OS X 10.2.8 to Mac OS X 10.3.x.

Page 87 3.PRINTING FROM MACINTOSH Enter the width and height in the [Page Size] boxes,
and select the printer name of this equipment in the [Printer Margins] box. Use the margin
settings that are automatically entered by selecting the printer name in the [Printer Margins]
box.

Page 88 3 PRINTING FROM MACINTOSH Creating Custom Page Size on Mac OS X 10.2.8 to
Mac OS X 10.3.x Select [Custom Paper Size] in the [Settings] box. The Custom Paper Size menu
is displayed. Click [New]. A new custom page size name is added to the list. If you want to
create a new custom page size by duplicating an existing custom page size, select the custom
page size name on the list and click [Duplicate].

Page 89 3.PRINTING FROM MACINTOSH Enter the width and height in the [Page Size] boxes,
and enter the printer margins in the [Printer Margins] boxes. In the [Printer Margins] box, enter
“0.17” inches. You can delete the created custom page size by clicking [Delete]. Click [Save]
and click [OK].

Page 90: Print Dialog On Mac Os X 10.3.X To Mac Os X 10.5.X
3 PRINTING FROM MACINTOSH Print dialog on Mac OS X 10.3.x to Mac OS X 10.5.x The [Print]
dialog boxes can be displayed by selecting the [Print] command from the [File] menu of the
application. The [Print] dialog boxes are different between Mac OS X 10.2.x and Mac OS X 10.3.x
to Mac OS X 10.5.x. See the following section for the descriptions of the [Print] dialog boxes for
Mac OS X 10.2.x.

Page 91 3.PRINTING FROM MACINTOSH Layout In the Layout menu, you can set N-up printing
(multiple pages per sheet). 1) Pages per Sheet This option sets the number of multiple pages
printed on one sheet. The pages are reduced to fit the selected paper size automatically and
are printed.

Page 92: Output Options
3 PRINTING FROM MACINTOSH - Short-edge binding — Select this option to bind along the short
edge side of the paper. The direction to be printed on the back side of the paper differs
depending on the orientation. Portrait Landscape Output Options In the Output Options menu,
you can save a print job as a file.

Page 93: Paper Handling
3.PRINTING FROM MACINTOSH Paper Handling In the Paper Handling menu, you can set Reverse
page order printing and Odd or Even numbered page printing. The screens in the Paper
Handling menu vary between Mac OS X 10.3.x and Mac OS X 10.4.x. Mac OS X 10.3.x 1)
Reverse page order Select this check box when you want to print a document beginning with
the last page.

Page 94 3 PRINTING FROM MACINTOSH Mac OS X 10.5.x 1) Page To Print Select whether all
pages will be printed or only odd or even pages will be printed. 2) Destination Paper Size Select
the output paper size. The paper size selected in the [Page Setup] dialog box appears as the
default setting. - Scale to fit paper size —...
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Page 95: Color Matching
3.PRINTING FROM MACINTOSH Color Matching The Color Matching menu that is specific to color
printers is not available for this equipment. This menu is displayed only for Mac OS X 10.5.x.
Cover Page In the Cover Page menu, you can set whether to send a print job with a banner
page. The banner page includes information about job owner, job name, application name, date
and time, and printer name.

Page 96: Error Handling
3 PRINTING FROM MACINTOSH Error Handling In the Error Handling menu, you can set how to
report a PostScript error. This menu is displayed only for Mac OS X 10.3.x to Mac OS X 10.4.x. 1)
PostScript Errors This sets whether to print a PostScript error report. - No special reporting —...

Page 97: Print Mode
3.PRINTING FROM MACINTOSH Print Mode In the Print Mode menu, you can set the way this
equipment handles the print job. This menu allows you to enable various job types, such as
Private Print, Proof Print and Hold Print. 1) Print Mode This option sets the type of print job.

Page 98: Printer Features
3 PRINTING FROM MACINTOSH 3) Do not Print Blank Pages Select whether to ignore blank pages
for printing. When more than 2 is selected at the [Page per Sheet] option in the Layout menu,
the blank pages will be printed. Pages with header or footer will be printed even if the content is
blank.

Page 99 3.PRINTING FROM MACINTOSH 2) Hole Punch This option sets whether or not a print
job is hole punched. - Off — Select this option to print without hole punches. - Long Edge Punch
without rotation — Select this option to create holes on the left side for a portrait document, or
on the top for a landscape document.

Page 100 3 PRINTING FROM MACINTOSH - Lower Left (Portrait) / Upper Left (Landscape) —
Select this option to staple on the lower left for a portrait document, or on the upper left for a
landscape document. - Upper Right (Portrait) / Lower Right (Landscape) — Select this option to
staple on the upper right for a portrait document, or on the lower right for a landscape
document.

Page 101: Cover Pages
3.PRINTING FROM MACINTOSH This option can be selected when the optional Finisher is
installed. Only [Upper Left (Portrait)/Upper Right (Landscape)] can be selected when the
Hanging Finisher (optional) is installed. [Saddle Stitch (Portrait) / Saddle Stitch (Landscape)] can
be selected only when the Saddle Stitch Finisher (optional) is installed.

Page 102 3 PRINTING FROM MACINTOSH 1) Use Front Cover This option sets front cover
printing which allows you to insert or print a cover on a sheet fed from a different drawer or the
bypass tray. To enable cover printing, select this check box and select the location from where
a cover sheet is to be fed and the print style to be used.

Page 103 3.PRINTING FROM MACINTOSH Quality In the Quality menu, you can specify various
image quality features. 1) Halftone This option sets how to print halftones. - Auto — Select this
option to print using proper halftone depending on the contents in the document automatically.
- Detail —...

Page 104: Print Dialog On Mac Os X 10.2.X
3 PRINTING FROM MACINTOSH Print dialog on Mac OS X 10.2.x The [Print] dialog boxes can be
displayed by selecting the [Print] command from the [File] menu of the application. The [Print]
dialog boxes are different between Mac OS X 10.2.x and Mac OS X 10.3.x to Mac OS X 10.5.x.
See the following section for the descriptions of the [Print] dialog box for Mac OS X 10.3.x to
Mac OS X 10.5.x.

Page 105 3.PRINTING FROM MACINTOSH 1) Pages per Sheet This option sets the number of
multiple pages to be printed on one sheet. The pages are reduced to fit the selected paper size
automatically and are printed. - 1 — Select this option if you do not wish to perform N-up
printing. - 2 —...
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Page 106 3 PRINTING FROM MACINTOSH - Short-edge Binding — Select this option to bind
along the short edge side of paper. The direction to be printed on the back side of the paper
differs depending on the orientation. Portrait Landscape Output Options In the Output Options
menu, you can save a print job as a file.

Page 107 3.PRINTING FROM MACINTOSH Paper Feed In the Paper Feed menu, you can select
the paper source or media type. 1) All pages from Select this option when you want to use the
same paper source for all pages. When this option is selected, select the paper source or paper
type to be used in the box.

Page 108 3 PRINTING FROM MACINTOSH 1) Booklet Paper Size Select a paper size for the
booklet. Both sides of a sheet are printed with two pages. The booklet size will be half the size
of the paper size that you specify. 2) Left to Right Page Layout Select this check box to create a
booklet that can be read from left to right.

Page 109 3.PRINTING FROM MACINTOSH Finishing In the Finishing menu, you can set the
destination, hole punching and stapling. 1) Destination This option selects the destination tray. -
Printer’s Default — Select this option to route the output to the default tray (that is set as the
default tray for raw job in the Printer setting page of TopAccess Administrator’s page).

Page 110 3 PRINTING FROM MACINTOSH - Long Edge Punch with 180 degree rotation —
Select this option to create holes on the right side for a portrait document, or on the bottom for
a landscape document. - Short Edge Punch with 180 degree rotation — Select this option to
create holes on the bottom for a portrait document, or on the left for a landscape document.

Page 111 3.PRINTING FROM MACINTOSH - Middle Right (Portrait) / Middle Bottom
(Landscape) — Select this option to double staple on the right for a portrait document, or on the
bottom for a landscape document. - Lower Right (Portrait) / Lower Left (Landscape) — Select
this option to double staple on the lower right for a portrait document, or on the lower left for a
landscape document.

Page 112: Printing Modes
3 PRINTING FROM MACINTOSH Printing Modes In the Printing Modes menu, you can set the way
this equipment handles the print job. This menu allows you to enable various job types, such as
Private Print, Proof Print and Hold Print. 1) Print Mode This option sets the type of print job.

Page 113 3.PRINTING FROM MACINTOSH Printing Modes DC In the Printing Modes DC menu,
you can specify your department code, if the Department Code option is enabled on the
equipment. Before specifying the department code, you must check the Department Code
option in the Printing Modes menu.

Page 114 3 PRINTING FROM MACINTOSH Private Document Password In the Private
Document Password menu, you can specify the Document ID number for the private job. It is
recommended to specify the Private Document Password when you select to print a private job.
If you do not specify the Private Document Password, the private job uses the default Private
Document Password “00000”.

Page 115 PRINTING FROM UNIX/Linux This chapter provides the instructions on how to print
from a UNIX/Linux workstation. Printing from an Application ... 114 Considerations and
limitations... 114 Printing using lp command ... 114 Generic “lp” and “lptap” options ... 114
General options ... 115 PCL5e Specific Options...123...

Page 116: Printing From An Application
4 PRINTING FROM UNIX/Linux Printing from an Application This section describes how to print
from a UNIX/Linux workstation. When the User Management Setting is enabled on the
equipment, the print jobs that are sent from UNIX/Linux workstations are processed as invalid
jobs according to the Department Code Enforcement setting. Before attempting to print from a
UNIX/Linux workstation, make sure all the UNIX/Linux Filters are installed in your workstation.

Page 117: General Options
4.PRINTING FROM UNIX/Linux General options The following options apply to all print files.
Option commands are case sensitive and must be entered exactly as shown. Some printing
functions may be disabled depending on the combinations of option commands because priority
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is given to the specifications of this equipment over option commands.

Page 118: Output Bin
4 PRINTING FROM UNIX/Linux Option Value Alternate Value staple=8 staple=9 If this option is
not specified, the printer’s default value will be used. Example: The command to staple in the
upper left corner of a long edge feed portrait page is “lp -d <queuename> -o staple=1
<filename>”.

Page 119: Media Type
4.PRINTING FROM UNIX/Linux Media Type The paper source can be selected using the following
options to specify the media type. Option Value Alternate Value mtype=Plain mtype=
Transparency mtype=Thick1 mtype=Thick2 mtype=Thick3 In PostScript, Deferred Media
Selection is always turned on so the paper size has priority over the media type and the paper
source.

Page 120: Paper Size
4 PRINTING FROM UNIX/Linux Paper Size The current paper size can be specified using the
following options. Option Value Alternate Value letter legal statement ledger folio folio-japan b4-
jis B4-JIS b5-jis B5-JIS computer legal13 lg13 LG13 sq85 letter-square postcard If this option is
not specified, the printer’s default value will be used. Example: The command to specify the A4
paper size is “lp -d <queuename>...

Page 121: Department Code
4.PRINTING FROM UNIX/Linux Department Code The department access code can be set using
the following option. Option Value Alternate Value dept=code How the equipment performs
printing for an invalid department code print job, for which an invalid department code is
specified, varies depending on the Department Code Enforcement setting that can be set from
TopAccess Administrator mode.

Page 122: Booklet Modes
4 PRINTING FROM UNIX/Linux Booklet Modes The booklet mode can be selected using the
following options. The booklet mode applies only for the PostScript data. Performing the booket
printing using the PCL data is invalid. Option Value Alternate Value booklet=letter booklet=A4
booklet=legal booklet=...

Page 123: Page Layout
4.PRINTING FROM UNIX/Linux Page Layout The booklet mode page layout can be selected using
the following options. Option Value Alternate Value left2right=off left2right=on Example: The
command to select left to right page layout for booklet printing mode is “lp -d <queuename> -o
left2right=on <filename>”.

Page 124: Font Pitch
4 PRINTING FROM UNIX/Linux Collate The collate option can be selected using the following
options. Option Value Alternate Value collate=off collate=on If this option is not specified, the
default value of “collate=on” will be used. Example: The command to select collate off is “lp -d
<queuename> -o collate=off <filename>”. Orientation The following orientation options are
available.

Page 125: Pcl5E Specific Options
4.PRINTING FROM UNIX/Linux PCL5e Specific Options Some of the options only apply to plain
text or PCL5e files. Text Wrapping The following options control text wrapping when it reaches
the right margin. Option Value Alternate Value wrap nowrap If this option is not specified, the
command will not be sent so the printer’s default value will be used. Example: The command to
specify wrapping is “lp -d <queuename>...

Page 126: Banner Page
4 PRINTING FROM UNIX/Linux Banner Page A banner page is automatically generated for each
file in each job. The banner page is always sent as a PCL5e job, including the following items.
The name of the user that submitted the print job The job ID number and from which
workstation it was submitted The title of the job This title can be specified using the “-t”...
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Page 127 4.PRINTING FROM UNIX/Linux Banner Options The banner page can be printed
using the following options. Option Value Alternate Value banner=last banner=first banner
nobanner The default value for this option is that the banner page prints first. Example: The
command to printing the banner page after the job is “lp -d <queuename> -o banner=last
<filename>”. Banner Paper Source The banner paper source can be specified using the
following options.

Page 129 MANAGING PRINT JOBS FROM THE CONTROL PANEL This chapter describes how to
use the control panel to control the print jobs and monitor the equipment. Monitoring the Print
Job Status ... 128 Normal Print/Scheduled Print jobs ...128 Proof Print jobs ...132 Private Print
jobs ...135 Hold Print jobs ...139 Invalid jobs ...143...

Page 130: Monitoring The Print Job Status
5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Monitoring the Print Job Status Your print
jobs can be monitored on the equipment’s touch panel. The types of print jobs you can monitor
include Normal Print, Scheduled Print, Private Print, Hold Print and Proof Print. If the Department
Management feature is enabled, the equipment can also display the Invalid jobs, which are held
without being printed.

Page 131: Deleting Jobs
5.MANAGING PRINT JOBS FROM THE CONTROL PANEL Deleting jobs Follow the procedure below
when you want to delete unnecessary Normal Print/Scheduled Print jobs. On the [JOBS] tab
listing the print jobs ( and then press [DELETE]. When “Delete OK?” appears, press [DELETE].
The selected job is deleted.

Page 132 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Pausing/Resuming jobs The
eleventh or subsequent job, when counted from the one in progress, can be held in the queue
(Pausing); the job in hold can be released again for printing (Resuming). Pausing jobs On the
[JOBS] tab listing the print jobs ( P.128), select the job that you want to pause and then press
[PAUSE].

Page 133 5.MANAGING PRINT JOBS FROM THE CONTROL PANEL Changing the job order You
can change the order of the jobs by moving them within the list. You can only move the jobs
from and to the 11th or subsequent position when counted from the one in progress. On the
[JOBS] tab listing the print jobs ( in the list, and then press [MOVE].

Page 134: Proof Print Jobs
5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Proof Print jobs Proof Print refers to the
function to print only a single copy as a sample and suspend the rest of the job when printing
multiple copies from a computer on the network. After viewing the first copy, you can decide, on
the Proof Print job list, whether to print out the remaining copies or cancel the job to change the
settings.

Page 135 5.MANAGING PRINT JOBS FROM THE CONTROL PANEL Printing remaining copies
Follow the procedure below if you have checked the first copy and want to print the remaining
copies. On the Proof Print job list ( If the target job is not displayed on the screen, use Press
[PRINT].

Page 136 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Deleting Proof Print jobs
Follow the procedure below to delete Proof Print jobs. On the Proof Print job list ( press
[DELETE]. If the target job is not displayed on the screen, use When “Delete OK?”...

Page 137: Private Print Jobs
5.MANAGING PRINT JOBS FROM THE CONTROL PANEL Private Print jobs Private Print refers to
the function to print a document from a computer on the network only when a set password is
keyed in to the equipment’s control panel. This function is useful when you want to print
confidential documents and prevent them from being seen by others.

Page 138 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Enter the password for the
Private Print job, which has previously been set via the computer, and then press [OK]. The
Private Print jobs are listed on the screen. When the Private Print job is sent from a Windows
computer: - When the user name that is entered to log in to your computer is used for [User
name (Alias)], the displayed list contains the Private Print jobs for which the same password has
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been set.

Page 139 5.MANAGING PRINT JOBS FROM THE CONTROL PANEL Printing Private Print jobs
Follow the procedure below to process your Private Print jobs from the control panel. On the
Private Print job list ( If the target job is not displayed on the screen, use If you want to select all
the jobs displayed on the screen, press [SELECT ALL].

Page 140 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Deleting Private Print jobs
Follow the procedure below to delete a Private Print job. On the Private Print job list ( press
[DELETE]. If the target job is not displayed on the screen, use If you want to select all the jobs
displayed on the screen, press [SELECT ALL].

Page 141: Hold Print Jobs
5.MANAGING PRINT JOBS FROM THE CONTROL PANEL Hold Print jobs Hold Print refers to the
function to retain a document from a computer on the network until a user performs printing
from the equipment’s touch panel. This function is useful to prevent you from forgetting to
remove printed sheets. Hold Print jobs can be released or deleted from the Hold Print job list.

Page 142 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL On the Hold Print job list,
select the desired user name. The displayed list contains the Hold Print jobs stored in the Hold
Print queue. When you enter the nickname for [User name (Alias)] on a Windows computer, and
send the job to the equipment, its nickname will be displayed on the Hold Print job list.

Page 143 5.MANAGING PRINT JOBS FROM THE CONTROL PANEL Printing Hold Print jobs
Follow the procedure below to process your Hold Print jobs from the control panel. On the Hold
Print job list ( If the target job is not displayed on the screen, use If you want to select all the
jobs displayed on the screen, press [SELECT ALL].

Page 144 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Deleting Hold Print jobs
Follow the procedure below to delete a Hold Print job. On the Hold Print job list ( press [DELETE].
If the target job is not displayed on the screen, use If you want to select all the jobs displayed
on the screen, press [SELECT ALL].

Page 145: Invalid Jobs
5.MANAGING PRINT JOBS FROM THE CONTROL PANEL Invalid jobs An Invalid job refers to a job
being held due to an incorrect or no department code entered for performing the job. If the
equipment is managed by the Department Management feature with the SNMP network
services enabled, entering an incorrect department code for printing from the touch panel
causes the job to be held as an Invalid job and stored in the Invalid job queue.

Page 146 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Printing Invalid jobs If you
have entered an incorrect department code for printing, you need to re-enter the correct one.
Follow the procedure below. On the Invalid job list ( If the target job is not displayed on the
screen, use Press [PRINT].

Page 147 5.MANAGING PRINT JOBS FROM THE CONTROL PANEL Deleting Invalid jobs Follow
the procedure below to delete an Invalid job. On the Invalid job list ( [DELETE]. If the target job
is not displayed on the screen, use When “Delete OK?” appears, press [DELETE]. The selected
job is deleted.

Page 148: Printing Files From Usb Media (Usb Direct Printing)
5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Printing files from USB media (USB Direct
Printing) USB Direct Printing refers to the printing of files saved in a USB storage device that is
connected to the USB port on the equipment.

Page 149 5.MANAGING PRINT JOBS FROM THE CONTROL PANEL Enter the department code
using the digital keys, and then press [OK]. The above screen will not be displayed when the
equipment is not managed with department codes. In this case, proceed to the next step. The
input department code appears as asterisks (*).

Page 150 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL In the list of files, select the
file that you want to print, and then press [SETTINGS]. If the target file is not displayed on the
screen, use To select a file contained in a folder, select the folder and press [OPEN]. In the list of
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files that appears, select the desired file to print.

Page 151 5.MANAGING PRINT JOBS FROM THE CONTROL PANEL Press [PRINT]. If you have
selected an encrypted PDF file for which a password has been set, proceed to step 9. The
equipment starts printing. The printouts are directed to the receiving tray. The job in progress
can be monitored from the [JOBS] tab listing the Normal Print jobs.

Page 152 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Press [OK]. The equipment
starts printing. The printouts are directed to the receiving tray. The job in progress can be
monitored from the [JOBS] tab listing the Normal Print jobs. Before Disconnecting the USB
Storage Device: Make sure that “USB DEVICE in use Do not remove USB DEVICE”...

Page 153: Viewing The Print Job Log
Viewing the Print Job Log You can view the log of print jobs on the touch panel. On the touch
panel, press [JOB STATUS]. Press [LOG] to display the [LOG] tab. 5 MANAGING PRINT JOBS FROM
THE CONTROL PANEL Viewing the Print Job Log...

Page 154 5 MANAGING PRINT JOBS FROM THE CONTROL PANEL Press [PRINT]. The Print Log
is displayed. On the Print Log, each job’s user name, date and time of the job, paper size, the
number of pages and the number of copies are displayed. Up to 120 jobs can be listed on the
log.

Page 155: Other Printing Methods
OTHER PRINTING METHODS This equipment also supports the following printing methods: FTP
Printing ... 154 Email Printing ... 155...

Page 156: Ftp Printing
6 OTHER PRINTING METHODS FTP Printing FTP printing is available when the FTP print service is
enabled on this equipment. You can print a document by sending the print file to this equipment
using the FTP. This equipment can accept the following files for printing: PCL file PS file...

Page 157: Email Printing
Email Printing Email printing is available when enabled on this equipment. You can print a
document by sending the print file, as an email attachment, to this equipment using the mail
client software. This equipment can accept only TIFF-FX (Profile S), TIFF-FX (Profile F) and TIFF-
FX (Profile J) files for printing. When the User Management Setting is enabled on the equipment,
the print jobs that are sent by Email printing are processed as invalid jobs according to the
Department Code Enforcement setting.

Page 159 APPENDIX This chapter describes the following contents. Internal Fonts List ... 158
Internal PCL fonts list ...158 Internal PS fonts list...159...

Page 160: Internal Fonts List
7 APPENDIX Internal Fonts List Internal PCL fonts list Courier CG-Times CG-Times Bold CG-Times
Italic CG-Times Bold Italic CG Omega CG Omega Bold CG Omega Italic CG Omega Bold Italic
Coronet Clarendon Condensed Univers Medium Univers Bold Univers Italic Univers Bold Italic
Univers Medium Condensed Univers Condensed Bold Univers Medium Condensed Italic...

Page 161: Internal Ps Fonts List
7.APPENDIX Internal PS fonts list AlbertusMT-Light AlbertusMT AlbertusMT-Italic AntiqueOlive-
Roman AntiqueOlive-Italic AntiqueOlive-Bold AntiqueOlive-Compact Apple-Chancery ArialMT
Arial-ItalicMT Arial-BoldMT Arial-BoldItalicMT AvantGarde-Book AvantGarde-BookOblique
AvantGarde-Demi AvantGarde-DemiOblique Bodoni Bodoni-Italic Bodoni-Bold Bodoni-BoldItalic
Bodoni-Poster Bodoni-PosterCompressed Bookman-Light Bookman-LightItalic Bookman-Demi
Bookman-DemiItalic Candid Chicago Clarendon-Light Clarendon Clarendon-Bold CooperBlack
CooperBlack-Italic Copperplate-ThirtyTwoBC Copperplate-ThirtyThreeBC Coronet-Regular
Courier Courier-Oblique...

Page 162 7 APPENDIX NewCenturySchlbk-Italic ZapfDingbats NewCenturySchlbk-Bold
NewCenturySchlbk-BoldItalic NewYork Optima Optima-Italic Optima-Bold Optima-BoldItalic
Oxford Palatino-Roman Palatino-Italic Palatino-Bold Palatino-BoldItalic StempelGaramond-Roman
StempelGaramond-Italic StempelGaramond-Bold StempelGaramond-BoldItalic Symbol Taffy
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Times-Roman Times-Italic Times-Bold Times-BoldItalic TimesNewRomanPSMT
TimesNewRomanPS-ItalicMT TimesNewRomanPS-BoldMT TimesNewRomanPS-BoldItalicMT
Univers-Light Univers-LightOblique Univers Univers-Oblique Univers-Bold Univers-BoldOblique
Univers-Condensed Univers-CondensedOblique Internal Fonts List...

Page 163: Index
INDEX Numerics ... 28 2-Sided Printing ... 24 A4 Tab ...52 [Account Settings] ...54 Account
Settings ... 94 All pages from ... 43 Angle ...21 [Basic] tab ...93 Billing Info ...103 Binding ... 99
Booklet ... 99 Booklet Center Margin ...32 Booklet Details ...

Page 164 ... 11 Model Selection ...43 Negative/Positive ...22 Normal Print ...131 changing
order ...129 deleting ...130 pausing ...130 resuming ...25 Number of Copies ...67 Number of
pages per Sheet ...29 Number of pages per sheet ...37 Number of tabs per Bank ...

Page 165 ...45 User name (Alias) ... 46 [Version Information] ...41 Watermark ...43 X Position
...146 XML Paper Specification (XPS) ...43 Y Position INDEX...

Page 166 INDEX...

Page 167 DP-2090/2520/3000/3570/4570 OME08018200...

Page 168 MULTIFUNCTIONAL DIGITAL SYSTEMS Printing Guide 2-17-2, HIGASHIGOTANDA,
SHINAGAWA-KU, TOKYO, 141-8664, JAPAN R081120G9100-TTEC 2009-03 ©2009 TOSHIBA TEC
CORPORATION All rights reserved...

This manual is also suitable for:

Estudio 255Estudio 355Estudio 305Estudio 455Estudio355Estudio 205l ... Show all
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